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{ƘŀǊǇ/ŀǇ ¦ǎŜǊ aŀƴǳŀƭ 
Copyright ©2018 Robin Glover and David Richards 

This version describes SharpCap 3.2. 

This is a pre-release copy of the User Manual and may contain errors. 

 

SharpCap is an image capture application designed primarily 

for Astrophotography and Video Astronomy. 

Support can be obtained via the SharpCap forum at http://forums.sharpcap.co.uk . 

You can download this manual in PDF format. 

  

http://forums.sharpcap.co.uk/
http://downloads.sharpcap.co.uk/downloaddoc.html?filename=SharpCapUserManual_v32.pdf
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Foreword 
SharpCap was born in frustration in February 2010. The frustration was with the typical applications 

used for webcam capture in Astrophotography at the time. AMCAP was a prime example ς it made it 

very hard to adjust the settings on your camera and very easy to do silly things like write over the 

previous capture file. These shortcomings were brought even more obvious when you were trying to 

use the program in the dark, on a laptop and while wearing gloves. 

My response to this ς a standard one for a software developer who has just encountered a poorly 

designed application ς ǿŀǎ ǘƻ ǘƘƛƴƪ ǘƻ ƳȅǎŜƭŦ ΨL Ŏŀƴ Řƻ ōŜǘǘŜǊ ǘƘŀƴ ǘƘŀǘΩΦ tŜǊƘŀǇǎ ƳƻǊŜ ǳƴǳǎǳŀƭƭȅ L 

actually decided that I would do better than that and I started to write SharpCap over the next few 

days. One of the hard parts of a software project is often deciding on a name, but the name 

SharpCap was easy to arrive at ς it comes from the programming language it is written in ς C# 

(pronounced C-sharp).  

Through its first year, SharpCap remained a fairly simple webcam capture application that was 

designed to be easy to use, to use standard, familiar Windows UI elements and to show the controls 

for the camera to the user at all times. This seemed to be enough of an improvement over the 

available alternatives to persuade a large number of people to start using SharpCap. 

About a yŜŀǊ ŀŦǘŜǊ {ƘŀǊǇ/ŀǇΩǎ ŦƛǊǎǘ ǊŜƭŜŀǎŜ ǎƻƳŜǘƘƛƴƎ unexpected (to me) happened ς I was 

approached out of the blue by an astronomy retailer selling Basler cameras asking if it would be 

possible to make SharpCap work with those cameras and offering to provide a sample camera to 

ǿƻǊƪ ǿƛǘƘΦ ¢Ƙƛǎ ŎƘŀƴŎŜ ŜǾŜƴǘ ŎƘŀƴƎŜŘ {ƘŀǊǇ/ŀǇΩǎ ŘƛǊŜŎǘƛƻƴ ŦǊƻƳ ŀ ǿŜōŎŀƳ ƻƴƭȅ ŀǇǇƭƛŎŀǘƛƻƴ ǘƻ ƻƴŜ 

that today supports a wide range of dedicated astro-imaging hardware. 

Over the years as well as adding support for more cameras, SharpCap has also added many more 

features to the extent that this user manual is now necessary as the application is sadly no longer 

ǎƛƳǇƭŜ ŜƴƻǳƎƘ ǘƻ ΨƧǳǎǘ ǳǎŜΩΦ ¢ƘŜ ǇǊƛƳŀǊȅ ŀƛƳ ǘƘǊƻǳƎƘƻǳǘ Ƙŀǎ ōŜŜƴ ǘƻ ǘǊȅ ǘƻ ƳŀƪŜ ǘƘƛƴƎǎ ǘƘŀǘ ŀǊŜ 

difficult simpler ς finding objects can be hard so the various image boost effects help find faint or 

out-of-focus targets; focusing can be hard so there are six focus assistance tools; DSO imaging is hard 

so live stacking makes it easier and of course polar alignment can be hard, but it is made simpler 

ǿƛǘƘ {ƘŀǊǇ/ŀǇΩǎ Ŝŀǎȅ ǘƻ ǳǎŜ ǇƻƭŀǊ ŀƭƛƎƴƳŜƴǘ ǘƻƻƭΦ 

I hope that you enjoy using SharpCap and that it indeed makes your astro-imaging easier. 

Clear Skies! 

Robin Glover, April 2018 

Copyright ©2018 Robin Glover  

Introduction 
SharpCap is an image capture application designed primarily for astrophotography and video 

astronomy. 

Support can be obtained via the SharpCap forum at http://forums.sharpcap.co.uk . 

This manual describes SharpCap 3.2. 

http://forums.sharpcap.co.uk/
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Requirements 

Supported Cameras 
SharpCap supports a wide range of cameras. These can be divided into 3 basic categories: 

1. Cameras supported directly by SharpCap ς these include many brands of dedicated 

astronomy cameras including models by Altair, Basler, Celestron, Imaging Source, iNova, 

QHY and ZWO. 

2. Cameras supported via a Windows Webcam driver ς includes most webcams (modified and 

unmodified), USB frame grabbers and is also an option for many specialised cameras where 

the manufacturer provides a webcam driver (sometimes called a WDM or DirectShow 

driver).  

3. Cameras supported via an ASCOM driver ς many astronomy camera manufacturers provide 

ASCOM drivers for their products and SharpCap can use these to communicate with the 

camera.   

Sometimes a camera can be accessed by two (or even all three) of the options above.  If that 

happens, it is usually best to prefer to use the direct support for the camera as this will give the most 

ŎƻƴǘǊƻƭ ƻǾŜǊ ǘƘŜ ŎŀƳŜǊŀΩǎ ŦǳƴŎǘƛƻƴŀƭƛǘȅΦ 

Altair Cameras 
A UK based supplier of a wide range of CMOS cameras for guiding, solar, planetary, lunar and deep 

sky imaging.  Altair cameras can also be purchased from a range of dealers in the UK and other 

ŎƻǳƴǘǊƛŜǎΦ  !ƭǘŀƛǊΩǎ ǿŜōǎƛǘŜ Ŏŀƴ ōŜ ŦƻǳƴŘ ŀǘ https://www.altairastro.com/ . 

Basler Cameras 
A German manufacturer of a wide range of industrial cameras, some of which are suitable for astro 

imaging.  SharpCap supports Basler cameras, including those with Gigabit Ethernet connectivity.  On 

some models of Basler cameras, SharpCap is capable of supporting exposures longer than the 

camera's normal maximum limit by clever software control of the camera's manual exposure 

triggers.  .ŀǎƭŜǊΩǎ ǿŜōǎƛǘŜ Ŏŀƴ ōŜ ŦƻǳƴŘ ŀǘ http://www.baslerweb.com/en . 

Celestron/Imaging Source Cameras 
The Imaging Source provide a wide range of industrial cameras which have been used for astro 

imaging for some time.  Imaging Source manufactured cameras are now sold under the Celestron 

brand.  SharpCap should be able to control the full range of The Imaging Source and Celestron 

cameras, although testing has covered the more common USB cameras only.  The LƳŀƎƛƴƎ {ƻǳǊŎŜΩǎ 

website can be found at https://www.theimagingsource.com/ . 

iNova Cameras 
iNova sell a range of small sensor CMOS/CCD cameras aimed primarily at the astro imaging market, 

primarily suitable for solar/lunar/planetary imaging and auto-ƎǳƛŘƛƴƎΦ  ƛbƻǾŀΩǎ ǿŜōǎƛǘŜ Ŏŀƴ ōŜ ŦƻǳƴŘ 

at http://inovaccdusa.com/ . 

Point Grey Cameras (now FLIR) 
Point Grey (now owned by FLIR) sell a wide range of industrial cameras that can also be used for 

astro imaging and scientific imaging. SharpCap supports most Point Grey cameras and provides full 

control over their functionality. More details on Point Grey cameras can be found at 

https://www.ptgrey.com/.  

https://www.altairastro.com/
http://www.baslerweb.com/en
https://www.theimagingsource.com/
http://inovaccdusa.com/
https://www.ptgrey.com/
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QHY Cameras 
QHY sell a wide range of CCD and CMOS cameras with sensor sizes ranging from webcam size to full 

frame SLR and beyond.  These cameras are primarily designed for the astro imaging and Scientific 

markets.  SharpCap supports the full range of QHY cameras and includes support for advanced 

features such as built-ƛƴ ŦƛƭǘŜǊ ǿƘŜŜƭǎΣ Dt{ ǘƛƳƛƴƎ ƳƻŘǳƭŜǎ ŀƴŘ tŜƭǘƛŜǊ ŎƻƻƭŜǊ ŎƻƴǘǊƻƭΦ  vI¸Ωǎ ǿŜōǎƛǘŜ 

can be found at http://www.qhyccd.com/ . 

StarlightXpress Cameras 
StarlightXpress produce a range of CCD based cameras designed specifically for astronomy use. 

SharpCap can control the full range of StarlightXpress cameras including the popular Lodestar family 

of highly sensitive guiding cameras. More details of StarlightXpress cameras can be found at 

https://www.sxccd.com/ . 

ZWO Cameras 
ZWO sell a range of CMOS cameras with low noise, high sensitivity sensors, ranging from webcam 

size to full frame SLR. Their cameras are primarily designed for the astro imaging market, including 

useful features such as built in USB hubs on some models. SharpCap supports the full range of ZWO 

cameras including control of advanced features such as Peltier cooler control and USB bandwidth 

adjustment.  Z²hΩǎ ǿŜōǎƛǘŜ Ŏŀƴ ōŜ ŦƻǳƴŘ ŀǘ https://astronomy-imaging-camera.com/ . 

ASCOM Cameras 
Many astro cameras have ASCOM drivers and SharpCap can use these drivers to control such 
cameras.  This can be a good fall back option when SharpCap does not have direct support for a 
camera.  The ASCOM Standards website can be found at  
http://www.ascom-standards.org/Downloads/CameraDrivers.htm . 

DirectShow Cameras 
Microsoft DirectShow is an architecture for streaming media on the Microsoft Windows platform.  

There are a vast number of webcams and frame grabbers on the market.  The controls available in 

SharpCap are determined by the driver ς SharpCap just shows the controls the driver makes 

available. 

Virtual Camera 
{ƘŀǊǇ/ŀǇ оΦн ŀŘŘǎ ǎǳǇǇƻǊǘ ŦƻǊ ŀ Ψ±ƛǊǘǳŀƭΩ ŎŀƳŜǊŀΦ ¢Ƙƛǎ ǿƻǊƪǎ ōȅ ǊŜŀŘƛƴƎ ƛƳŀƎŜ ŦƛƭŜǎ ŦǊƻƳ ŀ ǎŜƭŜŎǘŜŘ 

folder and treating the images as if they were frames received from a camera. SharpCap will read all 

existing images in the folder in date order and then wait for any new images that are created. You 

can use the virtual camera to use SharpCap features such as live stacking with previously captured 

images or with an unsupported camera if you have a program that will capture images from the 

camera and save them to disk. 

Choosing Between ASCOM and DirectShow 
If a camera appears as ASCOM and DirectShow ς which should be chosen? 
 
If a camera not directly supported by SharpCap is to be used, there are two options when connecting 
to it ς ASCOM drivers or DirectShow drivers.  Each have their pros and cons. 
 

ASCOM DirectShow 

Pros: 

¶ Direct control of exposure (continuously 
variable) in the SharpCap panel. 

Pros: 

¶ A better selection of camera controls 
available in the panel (gamma, brightness, 
contrast, etc.). 

http://www.qhyccd.com/
https://www.sxccd.com/
https://astronomy-imaging-camera.com/
http://www.ascom-standards.org/Downloads/CameraDrivers.htm
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¶ Binning may be available. 

¶ ROI may be available (2.10 and up). 

¶ Bit depths of >8 and RAW modes may be 
available. 

¶ Long exposures likely to be available. 
 
 
 
 
 
Cons: 

¶ Few other controls in the SharpCap panel 
as ASCOM doesn't allow for many except 
exposure and gain. 

¶ ASCOM is relatively slow, so frame rates 
will be slower. 

¶ ASCOM can be unreliable because each 
manufacturer interprets the standard in 
their own way, which can lead to some 
ASCOM drivers being incompatible with 
SharpCap. 

 

¶ Long exposures may be available (i.e. 1s, 2s, 
4s, 8s, 16s, etc.). 

¶ Region of Interest (ROI) may be available. 

¶ Extra controls may be available in the 
camera's DirectShow config dialog. 

¶ High frame rates possible. 

¶ Less likely to have compatibility issues than 
ASCOM. 

 
Cons: 

¶ Exposure only changeable in multiples of 2. 

¶ Bit depths limited to 8 bits and RAW modes 
unlikely to be available. 

¶ Can only save videos to AVI and images to 
PNG (2.9 only, this restriction removed in 
2.10). 

¶ Using an astro camera via DirectShow isn't 
as good as using it directly (less controls, 
less control over exposure), but it is better 
than nothing.  

 

Software 
SharpCap runs on Microsoft Windows. The minimum version requirement is: 

¶ SharpCap 2.9 (or older versions) ς Windows XP, Vista, 7, 8, 8.1, 10 

¶ SharpCap 3.0     ς Windows Vista, 7, 8, 8.1, 10 

¶ SharpCap 3.1 and 3.2   ς Windows 7 with SP1, 8.1, 10  

SharpCap is a 32-bit application and will install and run on both the 32-bit and 64-bit versions of 

Windows. 

Multiple major versions can co-exist, for example 2.8, 2.9 and 2.10 can be installed together on the 

same machine.  Only one minor version can be installed, for example only one of 2.9.3055 and 

2.9.3011 can be installed at any one time.  

Windows XP, although now out of Microsoft support, will work with older cameras.  The problem 

with this version of the operating system is manufacturer driver support for XP will dwindle, 

therefore newer cameras will be unable to run on the platform. 

Windows 7, 8.1 and 10 are well supported by manufacturers.  Windows 7 will go end of life in 2020 

and at this point, Microsoft support will cease.    

Hardware 
The minimum hardware requirement is dependent on the type of camera being used.  When 

purchasing a camera, look closely at the manufacturer/vendor recommended minimum PC 

specification. 

The following areas need to be considered to achieve the best frame rates: 

¶ Processor, i5 or i7 is better.  

¶ Memory, 3Gb maximum for 32-bit Windows, 64-bit needs at least 4Gb. 
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¶ Disk, SSD is faster than conventional drive. 

¶ USB, USB3 (5Gb/s) is 10x faster than USB2 (480Mb/s). 

¶ Windows 32/64-bit, 64-bit supports > 3Gb memory. 

SharpCap is designed to take advantage of the multiple CPU cores available on most modern 

computers and will perform better for fast cameras if more than one CPU core is available. 

Consider the hardware demands when purchasing high frame rate cameras. 

Minimum Hardware Specification 
A 640x480 resolution webcam will work well on a low specification PC.  A ThinkPad X61 (used to 

produce the examples in this manual) satisfies this requirement.  The following specification can 

achieve 30fps at 640 x 480 with a USB2 webcam. 

¶ Core 2Duo 1.86Ghz processor 

¶ 4Gb (3Gb usable with 32-bit Windows) 

¶ 120Gb SATA2 drive 

¶ Windows 10 32-bit 

Recommended Hardware Specification 
A dedicated astronomy camera capable of 3000x2000 pixels at 50fps will require a fast processor, 

more memory, an SSD and a USB3 port to achieve maximum performance.   

If intending to use high resolution cameras (10 Megapixels or more), ensure the capture PC/laptop 

has:  

¶ A minimum of i5 processor. 

¶ A large capacity hard drive (500Gb or more) with SSD preferred. 

¶ At least 4Gb (preferably 8Gb or more) of memory. 

¶ A 64-bit version of the Windows operating system.   

This configuration allows SharpCap to access more memory, thus reducing the likelihood of memory 

exhaustion while capturing.  This applies when working in RGB mode or at bit depths of 12 or 16 bits 

per pixel. 
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SharpCap Pro 
A number of the more advanced features of SharpCap now require the purchase of a SharpCap Pro 

license. SharpCap Pro licenses are reasonably priced, can be purchased for 1 or 5 years or a lifetime 

license and are available from http://store.astrosharp.co.uk/ . 

Installing SharpCap Pro 
You do not need to install a separate version of SharpCap if you wish to use SharpCap Pro features ς 

the SharpCap Pro features are already in the normal installed version of SharpCap ς they become 

available to you when you enter a SharpCap Pro license key. 

Trying out SharpCap Pro 
You can try out most SharpCap Pro features before purchasing a license. If you decide to try out one 

or more SharpCap Pro features without entering a license then SharpCap enters an evaluation mode 

where you cannot save any images until you close and then re-start the application. Evaluation 

mode allows you to see the effects of SharpCap Pro features on screen but not save the resulting 

images. 

When you try to use a SharpCap Pro feature without a license installed you will see a message like 

this 

 

which allows you to choose whether to use the feature in evaluation mode, purchase a new license 

or enter an already purchased one or you can choose not to use the feature after all. 

SharpCap Pro Features 
The table below shows the list of features that require a SharpCap Pro license. These features are 

ŀƭǎƻ ƘƛƎƘƭƛƎƘǘŜŘ ǿƛǘƘ ǘƘŜ ǘŜȄǘ ΨώtwhϐΩ ǿƘŜǊŜ ǘƘŜȅ ŀǊŜ ƳŜƴǘƛƻƴŜŘ ƛƴ ǘƘŜ ǊŜƳŀƛƴŘŜǊ ƻŦ ǘƘƛǎ ǳǎŜǊ ƎǳƛŘŜΦ 

http://store.astrosharp.co.uk/
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Feature Notes 

Dark Subtraction  

Live Flat Correction  

Polar Alignment You can measure your polar alignment error without 
needing a license. Guidance on adjusting to correct any 
error requires a license. 

Python Scripting Language  

Live Stacking Colour Adjustments  

Live Stacking and Display Histogram 
Autostretch 

 

Feature Tracking  

Seeing Monitor Seeing Triggered capture and Seeing Filtered capture can 
only be activated with a license. 

Smart Histogram  

Advanced Focus Score Features Automatic focus scans via ASCOM focuser require a 
license 

Live Stack Image Enhancements  

Live Stack Sigma Clipped Stacking  

Live Stack Dithering via PHD2  

Two Monitor View Image view on second monitor is watermarked if you do 
not have a license 

 

Buying a SharpCap Pro License 
SharpCap Pro licenses can be bought by visiting https://store.astrosharp.co.uk . Payment is accepted 

via PayPal. If you do not have a PayPal account then you can either choose to create one or choose 

to buy without creating an account using your credit or debit card (just follow the PayPal link anyway 

and you should see the option to buy using a credit or debit card). 

Once you have paid, your license will be sent to the email address that you used on the PayPal site, 

ǎƻ ǇƭŜŀǎŜ ƳŀƪŜ ǎǳǊŜ ǘƘŀǘ ƛǘ ƛǎ ŎƻǊǊŜŎǘΦ {ƻƳŜǘƛƳŜǎ ƭƛŎŜƴǎŜ ŜƳŀƛƭǎ Ŏŀƴ ƎŜǘ ŎŀǳƎƘǘ ƛƴ ȅƻǳǊ ΨWǳƴƪΩ ŜƳŀƛƭ 

folder so be sure to check if the license email does not arrive promptly. You will also see your new 

license in your web browser ς just let your browser return automatically to the AstroSharp website 

after completing your PayPal payment. 

Installing your SharpCap Pro License 
To install your new SharpCap Pro license, run SharpCap, go to the 'Help' menu and select 'SharpCap 

Pro License'. Copy the license text from your web browser or email and paste it into the license box. 

Be careful to include all of the license text.  

Once entered, your license should look like the example shown below (without the blurring!). Every 

line of text should start with a field name (like LicenseId or Expiry), followed by an equals sign ('=') 

followed by the field value. Don't include any other text and make sure you include all the lines 

shown. 

LŦ ȅƻǳǊ ƭƛŎŜƴǎŜ ƛǎ ŜƴǘŜǊŜŘ ŎƻǊǊŜŎǘƭȅ ǘƘŜƴ ȅƻǳ ǿƛƭƭ ǎŜŜ ǘƘŜ ƭƛŎŜƴǎŜ ǎǘŀǘǳǎ ŎƘŀƴƎŜ ǘƻ Ψ±ŀƭƛŘΩ ōŜƭƻǿ ǘƘŜ 

license entry box. 

https://store.astrosharp.co.uk/
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License Expiry and Renewal 
SharpCap Pro licenses are sold on a subscription basis ς that means that if you buy a one-year 

license, it will allow you to use SharpCap Pro features for one year from the date of purchase. If your 

license has expired then you will no longer be able to access SharpCap Pro features (but you will be 

able to continue using the many non-Pro features in SharpCap). Subscription based licensing allows 

the annual cost to be kept very low. 

You should receive two reminder emails in the weeks before your SharpCap Pro license expires to let 

you know that will soon be time to renew your license. You will also see notifications inside 

SharpCap itself warning you when your license will expire soon. 

If you choose to renew your SharpCap Pro license then you will receive a new license key. You will 

need to replace the existing license key in SharpCap with the new key, following the steps in 

Installing your SharpCap Pro License. The new key will be valid immediately, so there is no need to 

wait until your old key expires before making the change. 

Claiming a SharpCap Pro license bundled with a new Camera 
Some cameras are sold with an offer of a 1-year SharpCap Pro license included with the camera. If 

you have purchased one of these cameras then follow the steps below to claim the license. 

¶ Install any drivers necessary to allow your PC to detect the camera properly (for Altair 

cameras, this means you must install AltairCapture, even if you do not intend to use it) 

¶ Install the latest version of SharpCap 

¶ Ensure you are connected to the internet ς the license claim procedure requires a working 

internet connection. 

¶ Plug in your camera to a suitable USB port 

¶ Run SharpCap. If you do not have a SharpCap Pro license already, then a notification should 

appear at the top of the screen soon after SharpCap starts. 
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¶ /ƭƛŎƪ ƻƴ ǘƘŜ Ψ/ƭŀƛƳ [ƛŎŜƴǎŜ bƻǿΩ ōǳǘǘƻƴ 

¶ In the license claim window, enter your email address. Take care to enter your email address 

correctly, as you will receive a copy of your license by email. You can choose to share your 

email address with the camera manufacturer to receive updates and special offers if you 

want (this is entirely optional ς if you choose not to share your email address with the 

manufacturer then your email address will only be used to send you your licence key and 

remind you when it is about to expire). 

 
¶ Press the Claim SharpCap Pro License button ς after a few moments your claim will be 

processed and you should see a message confirming the license claim has been successful. 

Your license email should usually arrive within a few minutes. 

Note: Licenses included with purchases cameras are only valid for use with the specific brand of 

camera they were claimed against. 

Note: If you have purchased your camera second-hand then the previous owner may have already 

claimed the license for that camera ς in that case you will not be able to claim a SharpCap Pro 

license and will see this message if you do try to claim: 
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Quick Start 
This section describes getting started quickly and is intended for the experienced or impatient user. 

1. 5ƻǿƴƭƻŀŘ ǘƘŜ ƭŀǘŜǎǘ ŎŀƳŜǊŀ ŘǊƛǾŜǊ ŦǊƻƳ ǘƘŜ ƳŀƴǳŦŀŎǘǳǊŜǊΩǎ ǿŜōǎƛǘŜΦ 

 

2. Install the camera driver ς there may be a need to approve an administrator prompt or run 

the installer as administrator. 

 

3. Restart the PC/laptop.  

 

4. Attach the camera. 

 

5. Download the latest SharpCap from http://www.sharpcap.co.uk/sharpcap/downloads . 

 

6. Install SharpCap ς there may be a need to approve an administrator prompt or run the 

installer as administrator. 

 

7. Go to the camera menu and select the camera from the list of devices. 

 

 
 

http://www.sharpcap.co.uk/sharpcap/downloads
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8. If the camera is attached to a telescope or lens, a picture from the camera should be seen in 

the display area. 

 

 
 

9. Use the Camera Control Panel at the right-hand side of the screen to control settings such as 

exposure and gain.  The image should change in response to the controls being adjusted. 

 

10. Use the Start Capture (or Quick Capture) buttons to start a video capture to a new file or the 

Snapshot button to capture a single frame to a file.  

 

 
 

Once the capture has completed, a Notification Bar will appear directly below the Tool Bar.  

Click the highlighted link to go directly to the folder holding the captured image. 

 

 
 

11. The installation and testing of SharpCap is now complete. 
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Installation and First Steps 
This section is a step by step getting started guide. 

Installing the Camera Driver 
Do not connect a camera until its drivers have been installed.   Drivers are best installed from a 

Windows user account which has administrative privileges.  The drivers can be obtained in three 

ways, depending on the camera: 

1. Drivers delivered on a CD-ROM provided with the camera.  These might not be the latest 

version, so consider option 2. 

2. Links to camera manufacturersΩ websites can be found at http://www.sharpcap.co.uk/ , in 

the Supported Devices section or in Camera Controls in this document under the 

appropriate manufacturer.  

3. Microsoft supported webcams (which work with DirectShow) may download a driver 

automatically once the camera is plugged in.  This certainly works, for example, with the 

Microsoft LifeCam under Windows 10.  However, earlier versions of Windows require the 

LifeCam drivers to be downloaded from Microsoft.  

Once the camera drivers are installed, restart Windows, plug in the camera and check via Control 

Panel > Devices to see if the device (camera) is working properly. 

Installing SharpCap 
The download and installation of SharpCap is described here. 

1. Download SharpCap from http://www.sharpcap.co.uk/downloads .  The single download is 

suitable for both 32-bit and 64-bit versions of Windows. 

 

2. Navigate to the folder where SharpCap has been loaded.  Double click on the file 

SharpcapInstall-version-number.exe to install. 

3. Tick the box to agree to the license terms and conditions and press the Install button. 

 

 

 
4. Supply an administrator account name and password if requested. 

 

5. When the Installation Successfully Completed message appears, click Close to close the 

installer or Launch to run SharpCap straight away. 

http://www.sharpcap.co.uk/
https://www.microsoft.com/accessories/en-gb/products/webcams/lifecam-cinema/h5d-00014
http://www.sharpcap.co.uk/downloads
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6. SharpCap is now installed. 

Testing SharpCap 
Consider carrying out the initial testing from inside with the telescope and camera pointing at an 

object such as a tree, chimney, lamp or mast.  Choose a large object. 

12. Connect the camera to the telescope. 

 

13. Connect the camera to the PC. 

 

14. Start SharpCap.  From the main menu, select Cameras.  Ensure the camera is selected 

(ticked) ς in this example, the camera is a Microsoft LifeCam.  If the camera name appears 

twice, select the highest one on the list. 

 

 
 

15. This is {ƘŀǊǇ/ŀǇΩǎ Main Screen. 
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Key areas are: 

    Capture Display Area ς the image the camera sees is displayed here. 

    Quick Capture Button ς will start a video capture to a new file. 

    Snapshot Button ς will capture a single frame to a PNG file. 

    Exposure ς controls the camera exposure. 

 

If focusing of the telescope cannot be reached, try removing diagonals or adding extensions.  

   

16. Try the Snapshot button.  A Notification Bar will appear directly below the Tool Bar.  Click 

the highlighted link to go directly to the folder holding the captured image. 

 

 
 

17. This folder (SharpCap Captures\YYY-MM-DD) which is on the desktop, will contain 2 files.  

One is the image, the other is a text file containing the camera settings. 
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18. The camera settings file looks like this: 

 

 
 

19. Try the Quick Capture button.  At the bottom-right of the main screen, a progress bar should 

appear. 

 

 
 

20. When this video capture has completed, click the link in the Notification Bar.  The capture 

folder should contain a video file and a camera settings file.  Double click the video to play it. 

 

21. If all the above has worked, the SharpCap and camera installation has been successfully 

tested. 

Removing SharpCap 
This section describes the complete removal of SharpCap and all its ancillary settings.  This action 

might be required to perform a clean install with all old settings removed.  This work is best carried 

out with an account with administrator privileges 

Uninstall SharpCap ς either from Control Panel or via the Start button, go to Programs and Features, 

highlight SharpCap and Uninstall.  [Note: there may be multiple versions to choose from.] 

See the Appendix for additional (non-essential) clean-up actions. 
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Introduction to the SharpCap User Interface 
Upon starting SharpCap and dismissing the Tip of the Day message, the following screen appears: 

 

The SharpCap main screen consists of seven permanent areas and one temporary area.   

The permanent areas are: 

1. Title Bar ς shows the selected (active) camera (if any) and the default capture folder. 

2. Menu Bar ς gives access to SharpCap functions. 

3. Tool Bar ς gives quick access to tools frequently used for image capture.  When an image 

capture has completed a Notification Bar, giving save details, will appear below the Tool Bar.  

4. Capture Display Area ς shows the image currently being captured by the selected camera. 

5. Camera Control Panel ς gives access to all available controls for the selected camera.  Items 

displayed in this panel will vary depending on the type, model and level of support of the 

connected camera. 

6. Work Area ς used as a display area by tools such as Image Histogram, Calculate Focus Score 

and Live Stack. 

7. Status Bar ς gives ongoing information about frames captured/dropped and frame rate.  

During a capture, a progress bar will appear at the right-hand end of the status bar. 
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The temporary area is: 

1. Notification Bar ς appears below the Tool Bar upon completion of a Capture or Snapshot 

and provides a clickable link to go directly to the appropriate folder where the file has been 

stored.  The notification bar is also used to provide other information ς a green notification 

bar indicates success; a yellow bar indicates a warning and an orange bar indicates an error 

has occurred. 

 

 

Title Bar 
The Title Bar shows the selected (active) camera and the default folder for saving image captures.   

 

If no camera is active, only the default folder for saving image captures is shown. 

 

Menu Bar 
The Menu Bar gives structured access to many aspects of SharpCap functionality. 

 

Tool Bar 
The Tool Bar gives easy access to a collection of facilities commonly used when performing an image 

capture.  

  

From left to right, these are: 

1. Start Capture 

2. Quick Capture 

3. Stop Capture 

4. Pause 

5. Snapshot 

6. Live Stack 

7. Object Name 

8. Preview Effects (FX) 

9. FX Selection Area 

10. Reticule Overlays 

11. Zoom 

12. Image Histogram 
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13. Calculate Focus Score 

If the SharpCap window is not wide enough to accommodate all the tool icons, the Tool Bar will look 

like this with a down arrow at the right-hand end: 

 

Click the down arrow to access the rest of the tool icons: 

 

Capture Display Area 
The Capture Display Area shows the view currently being seen by the active camera. 

 

When a camera is selected in SharpCap (or SharpCap automatically selects a camera when it is 

started), SharpCap starts grabbing and displaying frames straight away.  SharpCap isn't saving these 

frames, just showing them on the screen.  Depending on the exposure length being used, the image 

may update many times per second or only once every few seconds (or even less frequently).  

SharpCap will only save images after use of the Start Capture or Snapshot buttons. 

Camera Control Panel 
The capabilities and available controls of the active camera are displayed in the Camera Control 

Panel.   These controls are used to adjust camera settings such as exposure, resolution, colour 

balance and others.  The groups and controls displayed can vary depending on: 

¶ The manufacturer of the attached camera. 

¶ The model of camera (even from the same manufacturer)  

See Camera Controls for a full description.  The controls are grouped logically and each group can be 

expanded/closed as required. 
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Work Area 
The Work Area is the display area for the following tools: 

¶ Live Stack 

¶ Histogram 

¶ Polar Align 

¶ Focus Score 

  

  

 

For each tool, the title bar of the panel can be used to drag the panel out of the main SharpCap 

form, for example to place it on a second monitor. 

Status Bar 
The Status bar at the bottom of the screen gives a constantly updated report on: 

¶ Frames captured 

¶ Frames dropped 

¶ Duration of capture 

¶ Capture speed, frames per second (fps) 

¶ Memory available and in use 

¶ Cooler Status (for cooled cameras) 
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¶ GPS Status (for GPS enabled cameras) 

 

Frame Progress 
When the exposure is set to 1s or longer, a progress bar will show on the right giving the progress of 

each frame 

 

The numbers to the right of the progress bar are the time elapsed so far in the frame and the time 

left to go in the frame (both in MM:SS). 

Some cameras take a considerable time to download a completed frame to the computer ς while 

the download is happening, the time remaining in the frame may show a negative value. A negative 

value may also show if the camera has stopped responding properly and SharpCap is stuck waiting 

for a frame that has not arrived. 

Capture Progress 
When an image capture has been initiated, a progress bar is displayed at the right showing: 

¶ Frames completed 

¶ Frames remaining 

¶ Estimated finishing time 
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The Menu Bar 

File 
The File menu item has the following options. 

 

SharpCap Settings 
The SharpCap Settings defaults have been chosen to enable ease of use of the application with 

minimal configuration required after installation, however adjustment to the settings can be made 

here when necessary. 

 

See Configuring SharpCap for a detailed description of the four tabs General, Hardware, Filenames, 

and Startup Scripts. 

Exit 
Selecting Exit or Alt+F4 will perform an orderly shutdown of SharpCap.  

Cameras 
The Cameras menu item allows selection and de-selection of attached imaging devices.  These may 

be cameras or video capture devices (frame grabbers). 

 

Different types of camera are grouped into different sections of the menu ς each section is headed 

by the description of the type of camera in that section ς ƛΦŜΦ Ψ!ƭǘŀƛǊ /ŀƳŜǊŀǎΩΣ Ψ5ƛǊŜŎǘ{Ƙƻǿ /ŀƳŜǊŀǎΩΣ 

Ψ½²h /ŀƳŜǊŀǎΩΣ ŜǘŎΦ  

Normally a new camera will be detected automatically when you plug it into your computer, but in 

some cases you may need to use the Rescan for Cameras option to detect a newly added camera. 

¢ǿƻ Ψōǳƛƭǘ-ƛƴΩ ŎŀƳŜǊŀǎ ŀǊŜ ǇǊƻǾƛŘŜŘΥ 

1. Test Camera 1 (Deep Sky), a simulation of a capture of the M42 Nebula in the Constellation 

of Orion. 
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2. Test Camera 2 (High Speed), a simulation of a capture of Jupiter (the dark spot to the lower 

left being the shadow of a moon).  

These two test cameras can be used to learn the functionality of SharpCap without requiring a 

telescope and camera. 

[Note: some cameras (particularly ASCOM and DirectShow cameras) may show in the device list 

even when they are not connected to the computer ς selecting one of these cameras not currently 

available will give an error message.] 

Rescan for Cameras 
If a camera connection is lost or a camera plugged in while SharpCap is open, use the Rescan option 

to find the device. 

SharpCap automatically rescans after a USB device is added to or removed from the computer.  The 

rescan button is mainly useful to detect network connected cameras (i.e. Basler or Point Grey Gig-E 

cameras) as SharpCap cannot detect these being added to the network. 

Close Camera 
This will close the currently open camera. A camera can also be closed by selecting the active camera 

a second time in the Cameras menu. Cameras are also closed automatically if a different camera is 

selected. 

Reconnect Camera 
This will stop then restart the currently connected camera. Under some circumstances this may help 

recover correct operation if a camera has become stuck or is not responding. If reconnecting the 

camera does not cure the problem then you may need to close and re-open SharpCap or disconnect 

and re-connect the camera. 

Available Cameras 
Select the camera to use from the dropdown list.  

There may be occasion when a camera appears twice in the available cameras list.  If in doubt which 

one to select, use the one highest in the list (because SharpCap tries to put the cameras it has the 

best control over at the top of the list).  See the Philips SPC 900NC in the graphic below. 
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Sometimes it is useful to close the camera currently in use without opening a different camera.  This 

can be achieved by returning to the Cameras menu and choosing the selected camera from the 

menu again. 

Options 
The Options menu item has the following items. 

 

Full Screen 
The Full Screen option forces SharpCap to switch to full screen mode.  This leaves only the Capture 

Display Area and Camera Control Panel visible ς there are no menu or tool bars available.  To reverse 

this situation, move the mouse pointer to the top of the screen and the menu will appear.  The Full 

Screen option can be unchecked. You can also switch in/out of full-screen view by pressing the F11 

key. 

Reset Control Order 
In the Camera Control Panel, each control group has a handle at the top right corner.  This handle 

can be grabbed with a mouse and the control moved elsewhere in the Camera Control Panel to suit 

individual preferences.  By choosing Reset Control Order, the control groups can be returned to their 

default order. 

 

Other Options 
Depending on the manufacturer/model of camera connected and selected in SharpCap, other menu 

items may appear in the Options menu. 

These are the additional menu items available when a Microsoft LifeCam (webcam) is connected and 

selected. 
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Capture 
The Capture menu item has the following options. 

 

 Capture allows control of: 

¶ The capture process. 

¶ The production of dark frames. 

¶ The creation of flat frames.  

See Capturing Videos and Images for a detailed description of these menu items. 

Tools 
The Tools menu item provides access to specific functions which can assist in capturing images or 

ensuring alignment of the telescope. 
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Histogram 
This option provides access to the main SharpCap histogram functionality. See The Histogram for a 

full description of this tool. 

Live Stack 
This option provides the same functionality as the Live Stack button located on the Tool Bar.  See 

Live Stacking for a full description of the tool. 

<ALT> < L> can be used as a hot key combination to initiate Live Stack. 

Polar Align 
Selecting Polar Align will produce a set of screens to manage the alignment process.  See Polar 

Alignment for a detailed description.  

Plate Solve 
¢Ƙƛǎ ǘƻƻƭ ƛƴƛǘƛŀǘŜǎ ŀ άōƭƛƴŘέ ǇƭŀǘŜ ǎƻƭǾƛƴƎ ǎŜŀǊŎƘ ǘƻ ŘŜǘŜǊƳƛƴŜ ǘƘŜ ŎŜƭŜǎǘƛŀƭ Ŏƻ-ordinates of the current 

image. The option will only be enabled if a compatible plate solving tool has been auto-detected or 

configured in the SharpCap settings. The progress and result of the plate solve operation will be 

shown in the notification bar. See Plate Solving Tab for more details on compatible plate solving 

tools and configuration. 

Sensor Analysis 
This tool launches the SharpCap sensor analysis routine which can measure the characteristics of 

your camera sensor. Once measured, the sensor data is stored and can be used in future to provide 

SharpCap smart histogram functionality. See Sensor Analysis and Smart Histogram for more details. 

Note that Smart Histogram is a SharpCap Pro feature. 

Focus Assistant 
The sub-options here allow the various Focusing tools to be selected. 

Seeing Monitor 
This launches the Seeing Monitor which can help you capture Lunar/Solar/Planetary images when 

the seeing is at its best. 

Collimation (Experimental) 
This launches the experimental Collimation assistant which may help with collimation of Newtonian 

telescopes. 

Feature Tracking (Experimental) 
This launches the experimental Feature Tracking tool, which can guide your mount during 

Lunar/Solar/Planetary imaging to keep the target from drifting out of view. 

Scripting 
The Scripting menu item allows access to the Scripting Console and gives the ability to run existing 

scripts and write new scripts.  The scripts are based on Python.  The functionality of SharpCap can be 

extended by using scripting as a built-in programming language. 

Scripting is an advanced topic and knowledge of it is not essential to be able to use SharpCap 

effectively. 
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See Scripting for a full description. 

Help 
The Help menu item has the following options. 

 

View Help 
View Help will display a manual, in Windows help file format, installed as part of the of the SharpCap 

software. 

SharpCap Pro License 
Allows you to enter or check your SharpCap Pro license. 

Check for Updates 
Selecting Check for Updates will initiate a version check against the SharpCap website of the installed 

versus latest version.  If no updates are available, the message below is displayed. 

 

If an update is available, a download and installation is offered. 

Report a Bug 
This option provides ŘƛǊŜŎǘ ƭƛƴƪ ǘƻ ǘƘŜ Ψ.ǳƎ wŜǇƻǊǘǎΩ ŀǊŜŀ ƻŦ ǘƘŜ {ƘŀǊǇ/ŀǇ ŦƻǊǳƳǎ. Before posting a 

new bug report in the forums, please check to see if the problem you are having has already been 

discussed ς there may even already be a fix or workaround for the problem! 

Support Forum 
This will launch the SharpCap forums in your web browser. You will find hints, tips, guides, and 

discussion of the use of SharpCap and general astronomy on the forums. 

Show LogSharpCap shows ASCOM focuser positions on the Focus score graphs 

 
SharpCap, in the background, is constantly logging events relating to the program. 
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Click the Copy to Clipboard button to copy the contents of the log.  By opening Notepad (or other 

text editor) the contents of the log can be pasted and a file saved.  The information on how to send 

the log file can be found at http://forums.sharpcap.co.uk/ . 

 

http://forums.sharpcap.co.uk/
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About 

 

The About window provides: 

¶ A link to the SharpCap website. 

¶ A message informing an upgrade to a SharpCap Pro License is available. 

¶ Acknowledgements. 

¶ A link to License Information. 

¶ A link to the SharpCap Facebook page. 

¶ Version and Change history. The currently installed version shown here is 3.2.5725. 

The About Window is shown here in the dark colour scheme. 
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The Tool Bar 

 

 

Start Capture 
The Start Capture button will start a video capture to a new file.  The functionality is identical to 

choosing Capture > Start Capture from the menu.  See Capturing Videos and Images for a full 

description. 

Quick Capture 
Clicking the Quick 
Capture button will 
initiate a video capture 
to a new file but use a 
pre-selected number of 
frames or seconds.   
 
To modify the pre-
selected value, click the 
down arrow and select 
a new value.  This value 
ǿƛƭƭ ōŜ ΨǊŜƳŜƳōŜǊŜŘΩ 
for future quick 
captures. 
 
 

 

 

<ALT> < Q> can be used as a hot key combination to initiate a Quick Capture. 

Stop Capture 
When a capture is in-progress, the Stop Capture button will be available and will stop the current 

capture. 

Pause 
When a capture is in-progress, the Pause button will be available and will pause capture.  This is 

useful if a cloud is passing over the object of interest. Pausing capture only stops frames from being 

saved to file ς the image shown on screen will continue to update. 

Snapshot 
The Snapshot button will capture the current image as seen in the display area to a PNG or FITS file.  

The location of the captured file appears in the Notification Bar below the Tool Bar, for example: 
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<ALT> <A> can be used as a hot key combination to initiate a Snapshot. 

Two Monitor View 
This button will only appear on a PC with two or more monitors connected (the monitors must also 

ōŜ ǳǎŜŘ ǘƻ Ψ9ȄǘŜƴŘΩ ǘƘŜ ŘƛǎǇƭŀȅ ǊŀǘƘŜǊ ǘƘŀƴ ΨaƛǊǊƻǊΩ ƛǘύΦ ²ƘŜƴ ǇǊŜǎǎŜŘ {ƘŀǊǇ/ŀǇ ǿƛƭƭ ǎǿƛǘŎƘ ōŜǘǿŜŜƴ 

the normal view on one monitor and a two-monitor view where the camera image is transferred to 

the second monitor and all controls remain on the initial monitor. This is particularly useful when 

Live Stacking as the live stacking controls can be allocated much more space on the first monitor. 

 

Live Stack 
This button initiates the Live Stack process.  The functionality is identical to choosing Tools > Live 

Stack.  See Live Stacking for a full description of the tool.  

<ALT> < L> can be used as a hot key combination to initiate Live Stack. 

Object Name 
Selecting Object Name in the main toolbar allows a pre-defined object to be selected and used as 

part of the capture folder hierarchy. 

 

A new name can also be typed here to represent the current object of interest ς  such as M42 or 

Orion Nebula.  

 

 Subsequent captures would be saved in a sub-folder called M42 (or Orion Nebula) under the default 

capture folder.  Objects added here will not persist across SharpCap restarts.  To become 

permanent, the object must be added via File > SharpCap Settings > General tab. 


























































































































































































































































































































































